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第一部分   汇编语言程序上机指导
当用户编制好汇编语言源程序之后，要使之在机器上运行，必须经过编辑、汇编、连接和调试几个步骤，如下图所示。
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图1 汇编程序上机流程

首先用编辑程序产生汇编语言源程序（扩展名为.asm的源文件）。源程序就是用汇编语言语句编写的程序，它不能为机器所识别，所以要经过汇编程序（宏汇编MASM或小汇编TASM）加以翻译。汇编程序的作用是把源文件程序转换成二进制代码表示的目标程序（扩展名为.obj文件）。在转换过程中，汇编程序将对源程序进行二遍扫描，如果源程序中有语法错误，则汇编结束后，汇编程序将指出源程序中的错误，用户还可以用编辑程序来修改源程序，最后得到无语法错误的目标程序（.obj文件）。

.obj文件虽然已经是二进制文件，但它不能直接上机运行，还必须经过连接程序（link）把目标文件与库文件或其它目标文件连接在一起形成可执行文件（扩展名为.exe文件），这个文件可以由DOS装入存储器，并在机器上运行。用户编制的程序往往不可能一次编制成功，总会有这样那样的部符合设计要求的错误存在，所以必须对程序进行调试。可用调试程序（如DEBUG、TURBO DEBUGGER等）进行各种方式的执行（单步、设断点或连续执行）调试，若发现错误，再对源程序进行修改。因此又要从编辑源程序开始，一步步进行，直到通过调试，不存在错误，此时的程序才是满足设计要求的合格程序。

1、编辑源程序

可以使用任一能够建立ASCII文本文件的编辑程序在磁盘上建立汇编程序文件。常用的编辑程序有WORDSTAR、WPS、NOTEPAD以及EDIT PLUS等等，本实验中使用的是EDIT PLUS2文本编辑软件，该软件可以作为多种语言的编辑工具，可以支持多种操作系统的应用程序格式，而且具有标尺显示功能，为检查程序提供了方便。

2、用TASM汇编产生目标文件

TASM（Turbo Assembler）是由Borland公司编写的汇编语言编译器，目前版本号为V3.1。在DOS环境下运行TASM.exe命令可完成对一个源文件的汇编，其命令格式为：

tasm  源程序文件名

设源程序文件名为 PROG.asm，当输入 tasm PROG.asm后，如果程序没有任何错误，则汇编过程及屏幕显示内容如下(其中画横线部分为用户输入，下同)：

C:\tasm\tasm PROG.ASM

Turbo Assembler Version 3.1 Copyright <c> 1998, 1992 Borland International

Assembling file:

PROG.ASM

Error messages:

None

Warning messages:

None

Passes:



1

Remaining memory:
456K

这时，编译器会产生一个PROG.obj的目标文件，为后面生成.exe文件作准备。如果程序出现错误，将在Error messages或Warning messages项中列出，根据相应的提示信息可以对源程序作出修改，直到汇编通过为止。

3、用tlink程序产生.EXE文件

汇编程序产生的目标文件（.obj文件），并不是可执行文件，必须用连接程序(tlink)把.obj文件转换为可执行的.EXE文件。主要原因是.obj文件中的存储器地址，分配的是浮动地址，还没有真正分配实际的存储器物理地址。另一方面，有些大的程序有许多程序模块组合而成，需要用连接程序把他们连接起来，再由连接程序分配真正的存储区。上述PROG.ASM的连接程序操作方法和屏幕显示如下：

C:\tink PROG

Turbo Link Version 2.0 Copyright <c> 1998, 1992 Borland International

Warning: no stack

连接程序给出的无堆栈段(no stack)的警告性并不影响程序的执行。这样，系统将生成一个PROG.exe的可执行文件，可以用于调试或执行了。

4、程序调试工具 Turbo Debugger

Turbo Debugger是BORLAND公司推出的源程序级调试器，它提供窗口、下拉式和弹出式菜单等图形操作方式并支持鼠标器。此外，与上下文相关的联机帮助使系统在调试操作的每个阶段能提供实时帮助，从而为程序设计人员提供强有力的快速交互调试环境。Turbo Debugger 在功能上除拥有Debug和Codeview所具有的基本操作外，还具有如下几个特征：

1） 可使用扩展内存来调试程序；

2） 强大的断点和记载功能；

3） 反向执行（跟踪）；

4） 使用远程系统调试程序；

5） 可调试TSR程序与设备驱动程序。

4.1、安装Turbo Debugger(TD)

（1）硬件与软件要求
Turbo Debugger运行于DOS环境，软硬件配置要求很低，一般RAM达到384k，DOS操作系统2.0以上即可完整运行。

（2）TD实用文件

为方便用户，Turbo Debugger安装盘提供如下几个实用文件：

1）README文件：用于对各安装程序的使用和安装说明。README文件一般可直接进入浏览。

2）HELPME!.doc文件：用于回答用户在使用TD时经常遇到的问题。

3）TDCONVRT.exe：完成CodeView到Turbo Debugger的转换，它让用户可以调试用Microsoft编译器所研制的C语言和汇编程序。

4）远程文件传送使用程序TDRF.exe：它与远程调试一起工作并且让用户向远程系统发出基本的文件维护命令。

5）符号表提取使用工具TDSTRIP.exe：它让用户无需重新连接就可以从程序中提取调试信息（或称为“符号表”）。

6) DMAP.exe文件：把调试信息附加到.map文件上。

  7) TDUP.exe文件：一个通用目标模块和.exe文件的反汇编程序。

（3）安装 如果把Turbo Debugger安装在C盘的TD目录中，则用

   C:\TD>A:install

然后按回车即可。

（4）启动  Turbo Debugger运行于DOS环境，在TD子目录下，键入TD即可进入Turbo Debugger调试系统。用户使用其它操作系统如Windows 3.X或Windows 95或其它更高级的操作系统，可先进入DOS模拟环境，然后再打开Turbo Debugger，如图2所示（为Windows2000 下进入的DOS环境）。
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图2  Turbo Debugger 调试界面

4.2、 Turbo Debugger调试功能简介

Turbo Debugger可以用来调试C语言、Pascal语言或者汇编语言编写的程序。这些语言既可以属于Borland Turbo系列，也可以由其它软件制造商提供。Turbo Debugger主要提供以下调试手段：

1） 跟踪（Tracing）：一次执行一行源程序。

2） 反向跟踪（Back tracing）：向后执行一步代码（反向执行）。

3） 单步（Stepping）：一次执行一行源程序，但跳过任何过程或者函数的调用。

4） 浏览（Viewing）：打开一个特殊窗口，以便从各种角度来检查程序的当前状态。包括变量、变量值、断点、堆栈内容、日志、源文件、CPU代码、内存、寄存器、执行历史、程序输出等。

5） 检查（Inspecting）：显示处理过程信息和复杂的数据结构内容。

6） 修改（Changing）：用指定的值替换全局或局部变量的当前值。

7） 监视（Watching）：隔离程序的变量，并在程序运行过程中跟踪并记录其值的变化情况。

（1）窗口

 1） 窗口说明：进入Turbo Debugger后，调试器窗口分为如下几部分：

· 模块窗口（Module window）：显示正在调试的程序代码。通过光标移动可考察数据和代码，并发出适当的局部菜单操作命令。

· 监视窗口（Watching window）：显示变量和其不断变化的值，当光标位于模块窗口的某个变量上时，用户可以按<CTRL>+<W>键把该变量值加到窗口中去。

· 断点窗口（Breakpoints window）：显示用户设置的断点。断点定义了程序中的一个位置，程序可以在该处停止运行以便检查其状态。断点窗口左边的方框列举了每个断点的位置，右边的方框表明当前高亮度断点生效的条件。

· 堆栈窗口（Stack window）：显示堆栈当前的状态。

· 记录窗口（Log window）：显示信息日志（message log）的内容。信息日志包含了在使用Turbo Debugger时产生的可滚动的信息与信息表。它告诉用户程序中止的原因、断点执行的结果、以及存储在日志中的窗口内容等。

· CPU窗口（CPU window）：显示CPU当前状态。该窗口有五个区，分别是反汇编机器指令、原始数据字节、原始十六进制字堆栈、CPU寄存器的值、CPU标志的状态。它让用户了解组成一行源代码的确切指令序列以及数据字节。如果用户程序停止在一行源代码中间的指令上，Turbo Debugger会自动打开一个CPU窗口。

· 寄存器窗口（Register window）：显示CPU寄存器与标志位的状态。本窗口有两个区，分别对应于CPU窗口的寄存器区和标志区。若无须了解CPU的其余状态时，可用本窗口查看寄存器的内容。

· 执行历史窗口（Execution History window）：显示汇编代码和源程序行。其中，上半部的窗口区中含有已被执行的汇编代码，可以反向执行；下半部的窗口区中主要显示即将执行的指令所对应的源代码行。

2）移动窗口与大小改变：当Turbo Debugger打开一个窗口时，它以缺省方式（大小）显示。如果用户要调整窗口大小或位置，可以用鼠标或Window/Size/Move（<CTRL>+<F5>）命令。在移动窗口或者改变其大小时，活动窗口的边界变为单线框。

3）关闭与回复窗口：在用完一个窗口后，可以选择Window/Close（<ALT>+<F3>）来关闭它。如果用鼠标器，亦可单击窗口左上角的关闭框。如果错误地关闭了窗口，可以选择Window/Undo Close或者按<ALT>+<F6>键来恢复它，但这仅对被关闭的最后一个窗口起作用。

（2）热键（Hot keys）常用的热键说明如表1所示。

表1 热键常用命令表

	键 
	菜单命令
	功能

	<F1>
	　
	联机帮助

	<F2>
	Breakpoints/Toggle
	在光标处设断点

	<F3>
	View/Module
	模块选择列表

	<F4>
	Run/Goto Cursor
	运行到光标位置

	<F5>
	Window/Zoom
	放大/缩小当前窗口

	<F6>
	Window/Next
	Window到下一个窗口

	<F7>
	Run/Trace Into
	执行单行源代码或单条指令

	<F8>
	Run/Step Over
	单步执行，跳过“调用语句（或指令）”

	<F9>
	Run/Run
	运行程序

	<F10>
	　
	激活或退出菜单条

	<ALT>+<F1>
	Help/Previous Topic
	显示最直接的帮助屏幕

	<ALT>+<F2>
	Breakpoints/At
	在一地址处设置断点

	<ALT>+<F3>
	Window/Close
	关闭当前窗口

	<ALT>+<F4>
	Run/Back Trace
	反向执行程序

	<ALT>+<F5>
	Window/User Screen
	显示用户程序屏幕

	<ALT>+<F6>
	Window/Undo Close
	重新打开刚被关闭的窗口

	<ALT>+<F7>
	Run/Instruction Trace
	执行单条指令

	<ALT>+<F8>
	Run/Until Return
	执行到从子程序返回

	<ALT>+<F9>
	Run/Execute to
	运行到一个特定地址

	<ALT>+<F10>
	　
	激活窗口局部菜单

	<ALT>+<SPACE>
	　
	到系统菜单

	<ALT>+<B>
	　
	到断点（Breakpoints）菜单

	<ALT>+<D>
	　
	到数据（Data）菜单

	<ALT>+<F>
	　
	到文件（File）菜单

	<ALT>+<H>
	　
	到帮助（Help）菜单

	<ALT>+<O>
	　
	到选项（Option）菜单

	<ALT>+<R>
	　
	到运行（Run）菜单

	<ALT>+<V>
	　
	到浏览（View）菜单

	<ALT>+<W>
	　
	到窗口（Window）菜单

	<ALT>+<X>
	File/Quit
	退出Turbo Debugger，并返回DOS

	<CTRL>+<F2>
	Run/Program Reset
	停止调试过程，重设程序，准备运行

	<CTRL>+<F10>
	　
	活动窗口局部菜单


（3）主菜单命令 按<F10>键激活主菜单条后，把光标移到一条目（选项）上，按回车，或按<ALT>加条目首字母即可激活子菜单。常见的命令选项简要说明如下：

1） 系统菜单（The System menu）

Repaint Desktop
刷新显示屏幕

Restore Standard
重新装入标准窗口布局

About



显示Turbo Debugger的有关信息

2） 文件菜单（The File menu）

Open

打开一待调试的新程序

Change Dir
改变目录

Get Info

显示程序信息

DOS Shell

开始DOS命令处理

Resident

结束Turbo Debugger并使其驻留内存

Symbol Load
装入独立于.exe文件的符号表

Quit


返回DOS

3） 编辑菜单（The Edit menu）

Copy


复制选定内容到剪贴板（Clipboard）上

Paste


把剪贴板内容粘贴到光标提示的位置上

Copy to log
把选定内容复制到日志记录中去

Dump pane to log  把选定的窗口复制到日志记录中去

4）浏览菜单(The View menu)

Breakpoints
检查（display）断点

Stack


检查

Log


检查数据或事件

Watches

检查被监视的变量

Variables

检查全局或局部变量

Module

检查程序源模块

CPU


检查CPU指令、数据或堆栈

Dump

   检查转贮源数据

Registers
   检查CPU寄存器和标志

5）运行菜单（The Run menu）

Run

   连续运行程序

Go To Cursor

执行到光标处

Trace Into

执行单行源代码或单条指令

Step Over

单步运行，跳过调用语句或指令

Execute To 
运行到指定地址

Until Return
运行到从某一个子程序返回

Back Trace

反向执行程序的一句源代码行或指令

Animate

连续单步执行程序

Instruction Trace
执行单条指令

Arguments

设置程序的命令行参数

Program reset
重新加载当前程序

6） 断点菜单（The Breakpoints menu）

Toggle

设置/取消光标处的断点

At

在指定的地址处设置一断点

Changed memory global 设置存贮区的全局断点

Expression True global  设置表达式上的全局断点

Delete All 清除所有断点

7）数据菜单（The Data menu）

Inspect
考察数据对象

Evaluate/Modify
计算表达式值

Add Watch

增加变量到监视窗口中

Function return 考察当前子程序的返回值

8）选项菜单（The Options menu）

Language

以源模块设置表达所用的语言

Display Options

设置屏幕选项

Path for source 

源程序所在目录列表

Save options

存选择项，窗口布局和宏定义到一磁盘文件

Restore options

从磁盘文件中恢复选择项

9）窗口菜单（The Window menu）

Zoom

放大窗口为全屏幕尺寸或缩小之

Next

激活屏幕上的后继窗口

Next pane

跳到窗口中的下一个区

Size/move

调整窗口大小或移动

Iconize/restore
把窗口变成图标或恢复

Close

关闭窗口

Undo Close
重新打开上一次关闭的窗口

User screen
显示用户程序输出

Open window list 显示已开窗口的列表，可选择激活其中某个窗口
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10）帮助菜单（The Help menu）

Index

转到联机帮助的索引上

Previous topic
  弹出帮助

Help on Help   在帮助系统中获得帮助机帮助

（4）局部菜单命令  按<ALT>+<F10>可弹出当前窗口下的局部菜单，也可用鼠标右键获取，如图3所示。在CPU窗口中，弹出局部菜单。下面简单介绍常用的窗口分区的局部菜单。

1） Break points window（断点窗口中）：本窗口分为两个区，左区为列表区，右区为细节区，只有列表区有一个局部菜单。

Set Options  设置断点的动作、条件、通过的计数和有效/无效

Hardware Options  允许设置硬件断点

Add   增加一个新断点

Remove    取消高亮度断点

Delete All   取消所有断点

Inspect    检查断点处的代码

（注：<Del>键是在本窗口下Remove命令的快捷键）。

2） CPU Window menu（CPU窗口中）：CPU窗口有五个区：代码区、数据区、堆栈区、寄存器区和标志区。每区都有自己的局部菜单。

· Code Pane（代码区局部菜单）

Goto  显示新地址处的代码

Origin  显示CS:IP处的代码

Follow  显示JMP或CALL目标处的代码

Caller   显示调用函数的代码

Previous  显示上一个地址处的代码

Search   搜索指令或字节

View Source  转到模块窗口

Mixed   反汇编和源代码的混合和显示方式：NO/YES/BOTH

New CS:IP   设置新的CS:IP

Assemble   汇编光标处的指令

· Data Pane（数据区局部菜单）

Goto   显示新地址处的数据

Search  搜索一个字符或数据串

Next  搜索下一个匹配的串

Change  修改光标处的数据字节

Previous   显示上一个地址处的数据

· Flags Pane（标志区局部菜单）

Toggle  设置或清除高亮度标志

           （注：在本区中，按回车或空格键可直接执行该命令。）

· Register Pane（寄存器区局部菜单）

Increment   当前高亮度寄存器加1

Decrement  当前高亮度寄存器减 1

Zero     当前高亮度寄存器清零

Change   修改当前高亮度寄存器值

Register 32－Bit  32位寄存器显示转换：  No/Yes

· Stack Pane（堆栈区局部菜单）

Goto   显示新地址处的堆栈内容

Origin  显示SS:SP处的数据

Follow  显示当前条目所指的代码

Previous   显示上一个地址处的代码

Change  用于编辑信息

3） File Window（文件窗口）：文件窗口以十六进制或ASCII方式显示磁盘文件内容。

        Goto  显示行号或十六进制的偏移量

        Search  搜索字符串或数据字节

        Next  搜索下一个匹配的串



   Display As  设置文件显示方式：ASCII/Hex

        File  转到一个新文件

Edit  在光标处编辑文件或修改字节

4） Watching Window（监视窗口菜单）：监视窗口只有一个区，显示被监视的变量名和值。

        Watch  增加一个变量或表达式到监视窗口

Edit  编辑一个监视变量或表达式

Remove  删除高亮度变量或表达式

Delete All  删除窗口中所有的变量或表达式

Inspect  显示高亮度变量或表达式的值

Change  修改高亮度变量的值，但不影响表达式

5） Inspector Window（考察窗口）

Range  选择待考察的数组元素

Change  修改高亮度条目的值

Inspect  为高亮度条目打开一个新的考察窗口

Descend  将高亮度条目在本考察窗口内展开

New Expression  在本考察窗口中考察一个新表达式

Type Cast  强行转换高亮度条目的类型

4.3、调试（汇编）程序

启动TD同时，可以同时使用选择项来设定其配置。命令的一般格式为：

td【选项】【程序名】

常用的选项有：

1）-d 选择项影响显示更新（display updating）操作的方式。

2）-do  在辅助显示（secondary display）中运行 Turbo Debugger，在主要显示（primary display）中观看用户程序。

3）-dp  使用彩色显示的缺省选择项。在一个显示页（display page）中显示调试器，而在另一中显示正在被调试的程序，这样最大程度地减少了在两个屏幕之切换的时间。当被调试的程序本身使用了多个显示页时，不能选择-dp。

4）-ds 使用单色显示的缺省选择项。它维持调试器与被调试程序独立的屏幕图像。每次运行用户程序或者调试器重新起动时，都从内存中加载整个屏幕的内容。

第二部分  上机操作

实验一  基本操作实验

一、实验目的：

1．掌握汇编编译器TASM和调试工具Turbo Debugger的设置和使用方法。

2．基本掌握汇编语言的编写、修改和编译与调试的方法。

3．熟悉断点设置和清除、程序复位、单步运行、跟踪、连续运行等软件调试方法。

4．学会检查、设置CPU各个寄存器和数据段内容，进一步丰富软件调试的手段。

二、实验内容

【例1】 数据块传送程序。要求把内存中某一区域的源数据块传送到另一区域。在编写该程序时，必须判别一下源数据区同目的数据区之间有无重叠，以决定是增量传送还是减量传送。程序清单如下：

DATA
SEGMENT







;定义数据段

STRG
DB 1000 DUP(?)








STG1
EQU STRG+8 




;定义源数据区域首地址

STG2
EQU STRG+16




;定义目的数据区域首地址

STRSE
EQU 10






;要传送数据的个数

DATA
ENDS

STA
SEGMENT PARA STACK'STACK'



;定义堆栈段

STARN
DB 100 DUP(?)

STA
ENDS

COSEG
SEGMENT

ASSUME CS:COSEG,DS:DATA,ES:DATA, SS:STA

GOO
    PROC FAR

BEGIN:

PUSH DS

MOV AX, 0 

PUSH AX

MOV AX, DATA

MOV DS, AX







;指定数据段位置

MOV ES, AX







;指定附加段位置

MOV CX, STRSE






;待传送的数据量赋给CX

MOV SI, OFFSET STG1




;源数据首地址赋给SI

MOV DI, OFFSET STG2




;目标数据首地址赋给DI

CLD








;增量方式传送

PUSH SI








;保护源数据首地址SI值

ADD SI, STRSE-1






;计算源数据首地址加上数据长

度后的地址值

CMP SI, DI







;判断源数据区首地址加上数据











长度后与目标数据区首地址的

大小关系

POP SI








;恢复源数据首地址值到SI

JB OK








;如果源数据区域在目标数据区

域之后,则跳转到OK行

STD









;减量方式传送

ADD DI, STRSE-1






;目标数据区域首地址指向数据

块底部

ADD SI, STRSE-1






;源数据区域首地址指向数据

块底部

OK:
REP MOVSB







;传送STRSE个数据


RET









;程序返回

GOO
    ENDP








;过程结束

COSEG
ENDS

END BEGIN
(1) 汇编与连接

TASM PROG.asm  回车

Tlink PROG    回车

如程序正确,可获得含调试信息的执行文件PROG.exe .

(2) 进入调试系统 Turbo Debugger 在调试可执行文件时，同时要求存在该执行文件对应的源文件，所以在调试PROG.asm时，应把PROG.asm文件拷入相应子目录中（假设为C:\TD\）。

在C:\TD\下，启动Turbo Debugger出现图2所示的调试窗口，在文件主菜单中，选中‘open’选项，出现如图4所示的文件对话框。选择正确的路径，找到PROG.exe文件，按下‘OK’即可进行调试。此时在模块窗口显示的是指令语句及代码，其它窗口显示该程序的各种状态。
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图4  执行文件打开的对话框

（3）设置源数据区域

1） 观察CPU窗口中显示的DS值，确定数据段的具体位置。

2） 修改数据段模块窗口中的地址值，可以通过右击数据区或在数据区按<ALT>+<F10>弹出局部菜单，选择goto命令，在本例当中，数据段地址为539F，因此要在地址栏中输入539F:0000显示的数据区转到数据段去，如图5所示。（注：由于编译器在不同的机器上分配的段地址是不一致的，因此在调试中要根据具体的地址来输入）。
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图5  显示程序数据段

3） 修改数据段中的数据。本例的源数据区域为ds:0008-ds:0011，目标数据区域为ds:0010-ds:0019，为了更好的观察到程序运行的结果，先在源数据区域输入1－10，方法是:在数据区右击所要修改的数据弹出局部菜单，选择change，然后进行修改，修改窗口的下部还有对修改数据历史的记录，修改完成按‘OK’保存。另外，还可以通过单击数据区要修改数据，然后按空格（<SPACE>）来修改数据，修改窗口以及修改后的结构如图6所示。
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图6  修改窗口以及修改结果

（4）单步跟踪执行

1） 在模块窗口中，利用鼠标移动指令代码，选取开始执行的语句（注：一般从程序开始处执行）。

2） 打开‘Run’菜单，反复选中‘Step Over’，即可单步执行程序（用户也可键入<F8>来完成），此时寄存器和CPU窗口分别显示程序的执行状态。

（5）在第十五条指令处设置断点，观察断点处的执行状态

1） 在模块窗口，用鼠标选中第三条指令。

2） 打开‘Breakpoints’菜单，选中‘Toggle’或直接按<F2>。

3） 选中第一条指令，准备执行程序，此时，第三条语句为高红亮显示，如图7所示，表明此处有断点。

4） 执行程序，观察模块和寄存器窗口。程序在第十五条语句处停止。
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图7 设置断点

5） 要清除断点，可以点击原来设断点的语句，再次选择Breakpoints/Toggle或按<F2>来清楚，如果要清楚所有断点，可以选择Breakpoints/Delete all 实现。

最后，程序运行结果如图8所示。
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图8 例1程序运行结果

可以看到目标数据段539F:0010-539F:0019的数据已经被源数据区域的数据所代替。

【例2】 从键盘输入一字符串(字符个数不大于10)，按回车结束，编制程序让屏幕反序显示该字符串。

参考程序如下：

DATA
SEGMENT







;定义数据段

STR_IN
DB 10 DUP(?)

STR_OUT DB 10 DUP(?)

CR DB 0DH, 0AH, '$'

DATA
ENDS

STA
SEGMENT PARA STACK'STACK'



;定义堆栈段

STARN
DB 100 DUP(?)

STA
ENDS

COSEG
SEGMENT


ASSUME CS:COSEG,DS:DATA,ES:DATA, SS:STA

GOO
PROC FAR

BEGIN:
PUSH DS







;程序初始化


MOV AX, 0 


PUSH AX


MOV AX, DATA


MOV DS, AX


MOV ES, AX


MOV SI, 0       

MOV DI, 0

MOV CX, 0







;用CX计算输入字符个数

INPUT:          

MOV AH, 1







;从键盘输入一个字符

INT 21H

CMP AL, 0DH






;判断字符串是否结束

JE INPUT_DONE






;遇到回车符则输入结束

MOV STR_IN[SI], AL





;没结束，存储输入字符

INC CX








;字符个数加1

INC SI








;修改输入地址

JMP INPUT







;再次输入

INPUT_DONE:

MOV AH, 9







;使屏幕光标移到下一行

MOV DX, OFFSET CR

INT 21H

OUPUT:


DEC SI








;使SI指向最后一个字符（第











一次执行时）

MOV AL, STR_IN[SI]





;把STR_IN的倒数第DI个字符











;赋给STR_OUT的第DI个位置

MOV STR_OUT[DI], AL

INC DI

LOOP OUPUT

MOV STR_OUT[DI], 24H




;给STR_OUT赋结束符

MOV AH, 9   






;在用户屏幕显示结果

MOV DX,OFFSET STR_OUT  

INT 21H

RET

GOO
ENDP

OSEG
ENDS

END BEGIN
（1） 汇编与连接，如例1对程序（STRING.asm）进行汇编与连接，并产生可执行文件STRING.exe。

（2） 进入调试系统 Turbo Debugger，选择菜单Run/Run全速运行程序，在用户界面输入‘1234abcd’，然后回车，如图9所示。
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图9 在用户界面输入字符

（3）之后程序提示程序运行完毕，这时可以选择菜单Window/User screen来查看程序运行结果，菜单位置及结果显示如图10和图11所示。
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图10 利用User screen观察程序运行结果
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图11 程序运行结果

三、实验要求

1、 认真阅读前面关于汇编程序调试的内容。

2、 熟悉参考程序。
3、 把例1中STG1的值与STG2的值交换，并修改对应的内存值，观察程序运行的结果。

4、 在例2中，要求把源字符串与转换后的字符串显示在同一行，源字符串在前面，两字符串用“=>”连接起来，编制程序实现上述功能。

实验二  数制转换程序设计实验

一. 实验目的：

1．进一步熟悉指令系统，提高编程能力。

2．掌握数制转换的设计方法。

3．熟悉循环程序、子程序、分支程序的编写和调试方法。

二．实验内容：

1． 编写将四个十六进制数转换为十进制数形式的程序。假定十六进制数存放在数据段X单元开始的区域中，转换得到的十进制数放在数据段RESULT单元开始的区域中。（如十六进制数2A，转成十进制数为42）

2． 把四个用压缩BCD码表示的十进制数转换成十六进制数。假定四个十进制数存放在数据段BCD_CODE单元开始的区域中，转换得到的十进制数放在数据段RESULT单元开始的区域中。

实验内容1参考程序：
data SEGMENT

X        DB  26H,30H,36H,10H

COUNT   EQU
4

RESULT   DB  COUNT DUP(?)

data ENDS

STA
SEGMENT


DB
64 DUP(?)

STA  ENDS

code SEGMENT

ASSUME CS:code, DS:data , SS:STA

MAIN:

MOV AX, DATA





；程序初始化

MOV DS, AX


MOV ES, AX

MOV AX, STA

MOV SS, AX

MOV SI, 0

MOV DI, 0

MOV CX, COUNT





；待转换次数送CX

NEXT:

MOV AL, X[SI]





；取数据

MOV AH, 0






；AX高8位清零

MOV BL, 10






；除数送BL

DIV BL







；十六进制数/10

SHL AL, 4






；商作为十进制数的高位

ADD AL, AH






；高位数与低位数合并

MOV RESULT[DI], AL




；保存结果

INC SI







；调整数据指针

INC DI

LOOP  NEXT





；循环控制

MOV  AH,4CH

INT  21H

Code   ENDS





；程序结束

END      MAIN

实验内容2参考程序：

data SEGMENT

BCD_CODE      DB  26H,95H,59H,10H

COUNT    EQU
4

RESULT        DB  COUNT DUP(?)

data ENDS

STA
SEGMENT


DB
64 DUP(?)

STA  ENDS

code SEGMENT

ASSUME CS:code, DS:data , SS:STA

main:

MOV AX, DATA






；程序初始化

MOV DS, AX


MOV AX, STA

MOV SS, AX

MOV SI, 0

MOV DI, 0

MOV CX, COUNT

NEXT:

MOV AL, BCD_CODE[SI]




；取十进制数

SHR AL, 4







；取高位数

AND AL, 0FH







；屏蔽高四位

MOV BL, 10







；乘数赋BL

MUL BL








；高位数×10

MOV BL, AL







；暂存乘积到BL

MOV AL, BCD_CODE[SI]




；再次取出十进制数

AND AL, 0FH







；屏蔽高位数

ADD AL, BL







；与转换完的十位数相加

MOV RESULT[DI], AL





；保存结果

INC SI








；修改地址指针

INC DI

LOOP NEXT







；循环控制

MOV  AH,4CH






；程序结束

INT  21H

code ENDS

END       main
实验三  ASCII码转换程序设计实验

一. 实验目的：

1．进一步熟悉指令系统，提高编程能力。

2．掌握ASCII码的在内存中的表示以及与其它码制的转换方法。

3． 掌握DOS基本功能调用的方法。

4．熟悉循环程序、分支程序的编写和调试方法。

二．实验内容：

1． 编写将四位十六进制数转换为ASCII码的程序。假定十六进制数存放在数据段X单元开始的区域中，转换得到的ASCII码存放在数据段Y单元开始的区域中，并把Y区域显示在用户屏幕中。
2． 写把四个字母转换大小写的程序，即把原来大写字母变成小写字母，小写的改成大写，并将其显示在用户界面上。假定源字符串以ASCII码的形式放在X单元开始的区域中，转换得到的字符串放在数据段RESULT单元开始的区域中。
实验内容1参考程序：

data SEGMENT

X          DB 15H,2FH








；源数据区域

COUNT    EQU
2









；数据个数

Y          DB 10 DUP(0)








；目标数据区域

TBLE      DB     30H,31H,32H,33H,34H,35H,36H,37H

；ASCII表

           DB     38H,39H,41H,42H,43H,44H,45H,46H

data ENDS

STA
SEGMENT


DB
64 DUP(?)

STA  ENDS

code SEGMENT

ASSUME CS:code, DS:data , SS:STA

main:

   

MOV AX, DATA





；程序初始化

MOV DS, AX

MOV SI, 0       

MOV DI, 0

MOV CX,COUNT





；X中数据个数赋CX

MOV BX,OFFSET   TBLE



；表首地址赋给BX

NEXT:

MOV AL,X[SI]





；取十六位数

AND AL,0FH






；屏蔽高四位

XLAT







；查表

MOV Y[DI],AL





；保存结果到Y

INC DI







；调整指针位置

MOV AL,X[SI]





；取十六进制数
SHR  AL,4






；AL高四位移到低四位

AND  AL,0FH





；屏蔽高四位

XLAT







；查表

MOV  Y[DI],AL





；保存结果到Y

INC SI







；修改源数据指针

INC DI







；修改目标数据指针

LOOP NEXT






；循环控制
MOV  AX,COUNT




；取X的数据个数

SHL  AX,1






；计算Y的数据个数

MOV  BX,AX







MOV  Y[BX+1],'$'




；为字符串Y写入结束符

MOV  AH,9






；显示字符串Y

MOV  DX, OFFSET Y

INT  21H

MOV  AH,4CH





；程序结束

INT  21H

code ENDS

END       main
实验内容2参考程序：

data SEGMENT

X
DB  'AaEb'






；源字符串

COUNT    EQU
4





；字母个数

RESULT
DB   COUNT+1 DUP(?)

data ENDS

STA
SEGMENT


DB
64 DUP(?)

STA  ENDS

code SEGMENT

ASSUME CS:code, DS:data , SS:STA

main:

MOV AX, DATA






；程序初始化

MOV DS, AX

MOV ES, AX

MOV AX, STA

MOV SS, AX

MOV SI, 0

MOV DI, 0

MOV CX, COUNT






；循环次数赋CX

NEXT:

MOV AL, X[SI]






；取源字母ASCII码

CMP AL, 'Z'







；是否小写字母

JA  LOWERCASE





；是，则跳转

ADD AL, 20H







；把大写字母转换成小写

MOV RESULT[DI], AL





；保存结果

JMP DONE







；单个字母转换完成

LOWERCASE:

SUB AL, 20H







；把小写字母转换成大写

MOV RESULT[DI], AL





；保存结果

DONE:

INC SI








；修改地址指针

INC DI

LOOP NEXT

MOV RESULT[DI], '$'





；给目标字符串赋结束标志

MOV  AH,9







；DOS调用显示字符串

MOV  DX, OFFSET RESULT

INT  21H

MOV  AH,4CH






；程序结束

INT  21H

code ENDS

END       main
实验四  数值运算程序设计实验
一. 实验目的：

1．进一步熟悉指令系统，提高编程能力。

2．掌握数值运算编程的基本方法。

3．掌握DOS基本功能调用的方法。

4．熟悉循环程序、分支程序的编写和调试方法。

二．实验内容：

1． 编制程序实现两个多字节数的求和。内存缓存区中定义两个四字节的二进制数（认为是无符号数或有符号数均可），分别存放在NUM1和.NUM2为首地址的四字节空间中（低位存放在低字节，高位存放在高字节），利用带进位加法求出二者的和，将其存放在从SUM开始的五个字节中，其中最高位的进位保留在最后一个字节中。

2． 编制程序实现数组元素求和。在内存缓存区中定义一个一维二进制数数组（认为是无符号数或有符号数均可），其元素个数不定，假定该数组以字符'$'结束，编制程序求出其所有元素之和（不包括结束字符）且记录其元素个数，将结果存放在内存中定义的以SUM为首地址的两个字节中(高字节存储低字节的进位)，元素个数存放在NUM开始的字节中。

实验内容1参考程序：

DATA

 SEGMENT

NUM1

 DB 23H,15H,2FH,0D4H




；定义第一个数据变量及初值

NUM2

 DB 0E3H,0A5H,17H,5DH




；定义第二个数据变量及初值

SUM  

 DB 5 DUP (?)               



；二者的和

DATA        ENDS
STACK

SEGMENT PARA STACK 'STACK' 


；定义堆栈段

DB 256 DUP (?)

STACK 

ENDS
CODE 

SEGMENT




ASSUME 
CS:CODE,DS:DATA,SS:STACK, ES:DATA

BEGIN:
MOV AX,DATA

MOV DS,AX







；设置数据段寄存器

LEA SI,NUM1         



；第一数首地址

LEA DI,NUM2       




；第二数首地址

MOV CX,4        




；每个数的字节数作为循环次数

CLC








；使进位标志为0

MOV BX,OFFSET SUM



；取和的首地址

NEXT:
MOV AL,[SI]

ADC AL,[DI]




；两数的第i个字节及c标志相加（i=1,2,3,4）

MOV [BX],AL





；存储和

INC BX







；和指针变化

INC SI







；数据指针变化

INC DI

LOOP 
NEXT

MOV 
AL,0             

ADC 
AL,0





；取最后一次进位标志值

MOV   [bx],AL





；存储之

MOV 
AH,4CH           

INT

21H






；返回dos

CODE
 ENDS

END 
BEGIN
实验内容2参考程序：

DATA SEGMENT

ARRAY
DB 0D7H,0E2H,43H,28H



；定义这个数组变量

DB 0F1H,0A9H,0D6H,0F6H,3DH


DB '$'









；定义数组的结束标志

SUM DB 2 DUP (?)







；数组的和

NUM DB ?








；数组的元素个数 

DATA ENDS
CODE SEGMENT

     ASSUME CS:CODE,DS:DATA

BEGIN:
MOV AX, DATA 

MOV DS,AX        

MOV DX,OFFSET ARRAY 

LEA SI,ARRAY





；取数组首地址

CLC








；进位标志淸0

MOV BX,0

MOV CL,0






；计数器初值

NEXT:

MOV AL,[SI]






；取数组第一个元素

cmp AL,'$'






；与数组结束标志比较

JE STOB







；若相等则转到存储

ADD BL,[SI]






；求和

INC CL







；计数器加1

INC SI







；数组指针加1

ADC BH,0






；取进位标志

JMP NEXT






；转入下一次循环

STOB:

MOV SUM,BL





；存储低位

MOV SUM+1,BH





；存储高位

MOV NUM,CL





；存储数组个数

OR CL,30H






；输出数组个数

MOV DL,CL

MOV AH,2

INT 21H

MOV DL,0DH





；输出回车字符

MOV AH,2

INT 21H

MOV AH,4CH





；返回dos

INT 21H

CODE ENDS

END BEGIN
实验五  求最值程序设计实验
一. 实验目的：

1．进一步熟悉指令系统，提高编程能力。

2．掌握无符号数和有符号数比较大小的编程的基本方法。

3．掌握DOS基本功能调用的方法。

4．进一步熟悉循环程序、分支程序的编写和调试方法。

二．实验内容：

1． 编制程序实现求出一维数组中的最大值和最小值。在数据段中定义一个一维数组，BUFFER为首地址,长度为10，编制程序检索此数组求出其中的最大值和最小值并分别存储在MAX和MIN两个字节单元中。

2． 编制程序求出一个一维数组的最值。此处以最大值为例，在数据缓存区中定义一个由八位二进制数组成的一维数组（无符号数），首地址是BUFFER，长度是10，编制程序求得其最大值并且存放在MAX字节单元中。

实验内容1参考程序：

DATA SEGMENT

BUFFER  
DB 0A7H,0D6H,0F7H,7BH,36H


；定义缓冲区数组(视为无符号数)

DB 0BFH,78H,67H,0CDH,12H; 

MAX DB ?                                       ；最大值

MIN DB ?                                        ；最小值

DATA ENDS 
STACK SEGMENT PARA STACK 'STACK'

DB 100 DUP (?)

STACK ENDS
CODE SEGMENT

ASSUME CS:CODE,DS:DATA,SS:STACK

BEGIN:MOV AX,DATA

MOV DS,AX

LEA SI,BUFFER





；取缓冲区首地址

MOV CX,10






；循环计数器置初值

MOV AL,[SI]






；取第一个数

MOV MAX,AL





；将第一个数存为最大值

MOV MIN,AL





；同时将它存为最小值

NEXT:

INC SI







；数组指针加1

MOV AL,[SI]






；取新数

CMP AL,MAX





；与MAX比较

JBE NEXT1






；若不大于MAX则转至NEXT1

MOV MAX,AL





；否则当前数据存入MAX

LOOP NEXT






；CX减1，若不为零转至下一循环

JMP STOP






；循环完则存储

NEXT1:

CMP AL,MIN






；与MIN比较

JAE NEXT2






；不小于MIN则转至NEXT2

MOV MIN,AL





；否则当前指存入MIN

NEXT2:

LOOP NEXT






；CX减1，若不为零转至下一循环

STOP:

MOV AH,4CH





；返回DOS

INT 21H

CODE ENDS

END BEGIN
实验内容2参考程序：

DATA SEGMENT

BUFFER

DB 0E5H,0D6H,65H,7DH



;定义缓冲区数组变量（无符号数）

DB 0F5H,0C3H,08BH,98H,90H,5FH

MAX

DB ?







；存放最大值

DATA     ENDS
STACK SEGMENT PARA STACK 'STACK'

DB 256 DUP (?)

STACK ENDS
CODE SEGMENT

     ASSUME CS:CODE,DS:DATA,SS:STACK

BEGIN:
MOV AX, DATA

MOV DS,AX

MOV SI,OFFSET BUFFER




；取数组首地址

MOV AL,[SI]







；取第一个数 

MOV CX,10







；计数器初值

NEXT: 

INC SI








；地址指针加1

CMP SI,10







；指针与10比较

JZ STOB








；若为10则存储

CMP AL,[SI]







；否则当前数与新数比较

JAE NEXT





；若不小于，则转至对下一个数的处理

MOV AL,[SI]







；否则将新数放入AL

JMP NEXT







；转至下一个数的处理

STOB:

MOV MAX,AL






；存储最大值

MOV AH,4CH






；返回DOS

INT 21H

CODE ENDS

END BEGIN
实验六  数据统计程序设计实验
一. 实验目的：

1．进一步熟悉指令系统，提高编程能力。

2．掌握统计数组中数的一些基本特征的编程的基本方法。

3．掌握DOS基本功能调用的方法。

4．进一步熟悉循环程序、分支程序的编写和调试方法。

二．实验内容：

1． 编制程序统计出一二进制数数组中的奇数和偶数的个数。在内存中定义一个一维数组ARRAY,，此数组以字符‘＃’结尾，编制程序统计出其中奇数和偶数各自的个数及此数组元素个数之和，将结果分别存储在JI,OU,NUM三个字节单元中，并在DOS屏幕上输出奇数的个数。

2． 编制程序统计出一个一维数组中的正数负数和零的个数。在内存数据据缓存区中定义一个八位二进制数组，以BUFFER为首地址，长度为10，试编制程序统计出其中正数，负数和零的个数，并依次存放在POS,PAS,ZERO三个字节单元中，并且在DOS屏幕上输出负数的个数。

实验内容1参考程序：

DATA SEGMENT

ARRAY DB 03AH,0DFH,5EH,15H,2BH,0CEH,4AH ;’#’

；定义被统计的数组

JI DB ?











；奇数个数

OU DB ?











；偶数个数

NUM DB ?










；数组元素个数

DATA ENDS
STACK SEGMENT PARA STACK 'STACK'

      DB 100 DUP(?)

STACK
ENDS
CODE   SEGMENT

ASSUME
CS:CODE,DS:DATA,SS:STACK

BEGIN: 
MOV AX,DATA

MOV DS,AX

MOV SI,OFFSET ARRAY



；取数组首地址

CLC








；进位标志清0

MOV BL,0






；寄存器清0（记录奇数个数）

MOV BH,0






；同上（记录偶数个数）

LOP2:

MOV CL,[SI]






；取数

CMP CL,'#'






；看是否结束标志

JZ STOB







；若是则转至存储

SHR CL,1






；逻辑右移一位

JC LOP1







；若最低位是1则转至lop1

INC BH







；否则，偶数计数器加1

JMP HERE

LOP1:

INC BL







；cy为1则奇数计数器加1

HERE:

INC SI







；数组位置指针加1

JMP LOP2






；转至下一个循环

STOB:

MOV JI, BL






；存储奇数个数

MOV OU,BH






；存储偶数个数

ADD BL,BH






；计算数组元素个数

MOV NUM,BL





；存储之

ADD BL,'0'






；输出奇数个数

MOV DL,BL

MOV AH,2

INT 21H

MOV AH,4CH





；返回dos

INT 21H

CODE  ENDS

END BEGIN
实验内容2参考程序：

DATA SEGMENT

BUFFER 
DB 0AH,45H,57H,0A7H,0D8H


；定义被统计数组变量

DB 00H,0F2H,0C3H,3DH,5EH

POS

DB ?








；正数个数

PAS

DB ?








；负数个数

ZERO
DB ?








；0值个数

DATA ENDS
STACK SEGMENT PARA STACK 'STACK'

DB
100 DUP (?)

STACK ENDS

CODE SEGMENT

ASSUME CS:CODE,DS:DATA,SS:STACK

BEGIN:
MOV AX,DATA

MOV DS,AX

MOV CX,10






；数据计数器置初值

XOR BX,BX






；BX清零（记录正负数个数）

XOR DL,DL






；DL清零（记录零值个数）

LEA SI,BUFFER





；取数组首地址

NEXT: 

MOV AL,[SI]






；取第一个元素

INC SI







；数组指针加1

CMP AL,0






；与零作比较

JGE LOP1






；若不小于0则转至LOP1

INC BH







；否则为负数，BH加1

LOOP NEXT





；CX减1，若不为零则转至下一循环

JMP STOB






；否则转至存储

LOP1:

ADD AL,0






；判断所取数是否为0

JZ LOP2







；若是则转至LOP2

INC BL







；否则即是正数，BL加1

LOOP NEXT





；CX减1，若不为0转至下一个循环

JMP STOB






；若所有数处理完则转至存储

LOP2:

INC DL







；是零，则DL加1

LOOP NEXT





；CX减1，若不为0转至下一个循环

STOB:

MOV POS ,BL





；存储正数个数

MOV PAS,BH






；存储负数个数

MOV ZERO,DL





；存储零的个数

ADD BH,'0'






；输出负数个数

MOV DL,BH

MOV AH,2

INT 21H

MOV AH,4CH





；返回DOS

INT 21H

CODE ENDS

END BEGIN
附录：ASCII码对照表

[image: image11.png]ASCII Control | ASCII ASCHl ASCII
value  Character character | value Character | value Character | value  Character
000 (null) NUL 032 (space) 064 @ 096

001 © SOH 033 I 065 A 097 a
002 ® STX 034 066 B 098 b
003 v ETX 035 # 067 c 099 c
004 3 EOT 036 $ 068 D 100 d
005 - ENQ 037 % 069 E 101 e
008 a ACK 038 & 070 F 102 {
007 (beep) BEL 039 ‘ 071 G 103 g
008 B BS 040 ( 072 H 104 h
009 (tab) HT 041 ) 073 1 105 i
010 (line feed) LF 042 . 074 ] 106 i
011 (home) VT 043 i 075 K 107 k
012 (form feed) FF 044 : 076 L 108 1
013 (carriage return) CR 045 077 M 109 m
014 n SO 046 . 078 N 110 n
015 oY s 047 / 079 o 111 °
016 - DLE 048 0 080 P 112 P
017 - DC1 049 1 081 Q 113 q
018 3 DC2 050 2 082 R 114 Y
019 1 DC3 051 3 083 S 115 s
020 W DC4 052 4 084 T 116 t
021 § NAK 053 5 085 U 117 u
022 — SYN 054 6 086 v 118 v
023 1 ETB 055 7 087 w 119 w
024 T CAN 056 8 088 X 120 X
025 i EM 057 9 089 Y 121 v
026 = SUB 058 : 00 Z 122 z
027 - ESC 059 091 [ 123 {
028 (cursor right) FS 060 092 N 124 !
029 (cursor left) Gs 061 093 ] 125 }
030 (cursor up) RS 062 > 094 126 -
031 (cursor down) us 063 ? 095 127 =)





[image: image12.png]AscIl

ASCHl ASCHl ASCII
value  Character value Character value Character value  Character
128 [ 160 a 192 [= 224 «
129 o 161 i 193 + 225 [
130 é 162 o 194 - 226 I
131 & 163 0 195 [ 227 ™
132 & 164 i 196 — 228 ¥
133 & 165 N 197 + 229 o
134 & 166 a 198 E 230 w
135 ¢ 167 o 199 I+ 231 T
136 & 168 ¢ 200 2 232 ®
137 é 169 — 201 i 233 ]
138 & 170 — 202 L 234 Q
139 i 171 v 203 F 235 6
140 i 172 2 204 I 236 x
141 i 173 i 205 = 237 [}
142 A 174 « 206 Ak 238 £
143 A 175 » 207 L 239 n
144 E 176 208 . 240 =
145 ® 177 209 = 241 *
146 & 178 210 - 242 =
147 6 179 | 211 w 243 <
148 6 180 - 212 = 244 r
149 o 181 = 213 = 245 J
150 a 182 B 214 '3 246

151 u 183 - 215 # 247

152 y 184 = 216 + 248

153 ] 185 = 217 ] 249 .
154 U 186 I 218 r 250 .
155 ¢ 187 = 219 = 251 v
156 £ 188 = 220 = 252 n
157 ¥ 189 o 221 ] 253 2
158 Pt 190 - 222 i 254 =
159 f 191 A 223 e 255 (blank ‘FF')
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图3 局部菜单
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人生有一道难题，那就是如何使一寸光阴等于一寸生命。
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